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5 – АМАЛИЙ МАШҒУЛОТ

ХАРИТА ТАҚДИМОТИ
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КИРИШ 

ArcMap да хариталар фазовий маълумотларга асосланади. Фазовий маълумотлар 
қайси объектларни намойиш этишини аниқловчи атрибут маълумотлари билан 
бирга ер юзасида географик объектлар ва жойлашиш ўрни ҳамда уларнинг 
ўртасидаги боғлиқликлар тўғрисида маълумотларни билдиради.

Сиз бу комплекс маълумотларни жадваллар ёки рўйхатга кўра хариталардан кўпроқ 
самарали фойдаланишингиз мумкин чунки, хариталар рангларни, нақшларни 
интерпретация қилиш ва фазовий алоқаларни ажрата олиш каби табиий 
имкониялардан фойдаланиш устунлигига эга. Агар сиз маълумотларингизни 
харитада қулай тарзда намойиш этадиган бўлсангиз, олдин кўриш имконияти 
бўлмаган фазовий тақсимланишларни, алоқаларни ва йўналишларни кўришингиз 
мумкин. Сизнинг хариталарингиз қарор қабул қилишда ва муаммоларни ечишда 
ёрдам бериши мумкин. Қолаверса, улар сизнинг маълумотларингизни ва 
натижаларни бошқаларга кўпроқ фойдали равишда етказишга ёрдам беради. 

Географик хариталарни яратишингизда унда қандай маълумотларни намойиш 
этишни танлаш жуда муҳим қарор ҳисобланади. Сизнинг маълумотларингизни 
белгилаш учун объектларни намойиш этишда тўғри белги ва рангларни танлашни 
жалб этади. Бу уларнинг атрибутлари ва атрибут қийматларига боғлиқ ҳолда 
объектларни гуруҳлашни ёки синфлашни тақозо этади.  

________________________________________________________________________

Ушбу амалий машғулотда:

 Фазовий маълумотларни белгилаш;
 Матн ва графикларни харитага қўшиш;
 Маълумотлар тўпламини маркировка қилиш;
 График белгилари ва атрибутлардан фойдаланиш (Bertin);
 Харитани тақдим этиш учун 12 қадамдан фойдаланиш ўргатилади.

Вазифалар

Ушбу амалий машғулотни ўзлаштиргандан кейин қуйидагиларни бажара оласиз: 
 Харитани тақдим этиш учун 12 та қадамдан фойдаланиш;
 Маълумотларни символлаштириш: географик белгиларни/символларни ва 

атрибутларни тўғри танлаш.
 Тўлиқ форматдаги харитани яратиш.

ArcMap ҳужжати:  Map presentation1.mxd, Map presentation2.mxd 
ва Map presentation3.mxd

Адабиёт: Chapter 10 Data display and cartography
Chapter 11: section 11.5 Geographic visualization
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МАЪЛУМОТНИ БЕЛГИЛАШ УЧУН БЕЛГИЛАР РЕДАКТОРИДАН
ФОЙДАЛАНИШ

Географик хариталарни яратишингизда унда қандай маълумотларни намойиш
этишни танлаш жуда муҳим қарор ҳисобланади. Сизнинг маълумотларингизни
белгилаш учун объектларни намойиш этишда тўғри белги ва рангларни
танлашни жалб этади. Бу уларнинг атрибутлари ва атрибут қийматларига
боғлиқ ҳолда объектларни гуруҳлашни ёки синфлашни тақозо этади. 
Символлар билан кўрсатиш/symbolization маълумотларни ўрганиш, тушуниш ва
таҳлил қилиш учун кучли асбоб ҳисобланади.

Белгилар редактори/Symbology editor

1 – амалий машғулотда белги редактори/Symbology editor муҳокама қилинган
эди. Бу амалий машғулотда ‘маълумотларингизни белгилаш’ / ‘Symbolizing
your data’ қисмини қайта яна ўрганиш имконияти мавжуд.

Сиз намойиш ойнасида/view window (1-амалий машғулотга қаранг) 
маълумотлар тўламини қандай бошқариш учун Layer properties ойнасидаги
Symbology иловасидан фойдаланасиз. Symbology editor очилганда сиз ҳар бир
маълумот тўплами учун харита турини/map type сизнинг харитангиз намойиш
этадиган маълумотларнинг турига асосланиб танлашингиз мумкин. Танлаш
учун ҳар хил харита турлари ArcMapда мавжуд. 
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1-расм. Символлар редактори, бу ерда намойиш этилаётган харитангиз
усулини ўзгартиришингиз мумкин./ The symbology editor; where you can change 
the way your data is displayed.

Объектлар/Features:
Маълумотлар тўпламида барча объектлар single symbol орқали белгиланади. 

Категориялар/Categories:
 Unique values of one field: битта атрибутнинг (атрибут=майдон) 

қийматларидан фойдаланиб категорияларни/синфларни намойиш этади;
 Unique values of many fields: 3 та атрибутгача бўлган ноёб атрибут 

комбинацияларининг қийматларидан фойдаланиб 
категорияларни/синфларни намойиш этади; 

 Match to symbol in a style: Услубда белги рўйхатидаги символларни 
атрибут қийматларига мослаштириш орқали категорияларни/синфларни 
намойиш этади;

Миқдорлар/Quantities:
 Graduate color: миқдор қийматлари билан атрибутда белгиланганидек 

ранглар шкаласидан фойдаланиб моқдорларни намойиш этади.  
 Graduate symbol: атрибутни белги ўлчами орқали аниқловчи символ 

ўлчамининг ўзгаришидан фойдаланиб миқдорларни намойиш этади. 
 Proportional symbol: аниқ қийматни кўрсатиш учун символ ўлчамлари 

орқали аниқловчи символ ўлчамининг ўзгаришидан фойдаланиб 
миқдорларни намойиш этади; 

 Dot density: атрибут қийматларида белгиланганидек нуқта зичлигидан 
фойдаланиб миқдорларни намойиш этади. 

Диаграммалар/Charts:
 Pie: ҳар бир объект учун кўп сонли атрибутларда белгиланганидек 

айланма диаграммани намойиш этади;
 Bar/Column: ҳар бир объект учун кўп сонли атрибутларда 

белгиланганидек чизиқча/bar ёки устун/column шаклини намойиш этади. 
 Stacked: ҳар бир объект учун кўп сонли атрибутларда белгиланганидек 

трубасимон /stack шаклидаги диаграммани намойиш этади.

Кўп сонли атрибутлар/Multiple attributes:
 Категорияли миқдор: бир ёки бир неча атрибутларни ҳар бир 

категория/класс учун миқдорни кўрсатади.

1. 
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‘Map presentation1.mxd’ ҳужжатини ArcMapда очинг. ‘Wag_south1’ маълумот
рамкасини актив ҳолатга келтиринг ва ‘Soil_types’ маълумот тўпламининг
Symbology редакторини очинг.

1а. ‘Soil_types’ маълумотлар тўпламини кўрсатиш учун қандай турдаги
харитадан фойдаланилган?

1b. Бу ранг нимани акс эттиради?

Харита турлари ва маълумот масштаблари/Map types and data
scales

ҚЎЛЛАНМА:

1. Малумот рамкасини актив ҳолатга
келтиринг, маълумотлар тўпламини
текширинг ва Symbology редакторини
очинг (Layer properties ойнасида)
2. Харита турини/map type танланг, 
маълумотни кўрсатиш учун Values 
легендасидаги пастки рўйхатдан
атрибутни танланг. Categories => 
‘unique values‘ни танлаганингизда ‘add 
all values’ да ‘all other values’ ни
белгиламасликни/uncheck унутманг. 
3. Symbology редакторида символни 
ўзгартириш учун уни икки марта босинг. 
Symbol Selector ойнаси пайдо бўлади (2-
расм). 

4. Symbology selector олдиндан аниқланган символларни танлашни 
таъминлаб беради. Буларни  Preview ёки Properties тугмаларини танлаш орқали 
ўзгартириш мумкин. 
5. Сиз шунингдек, олдиндан аниқланган символлар тўпламини (масалан: 
ўрмон/forestry, тупроқ/soils ва геология/geology) More Symbols тугмасини 
босиш орқали танлашингиз мумкин. 

2-расм. Символ танлагич/Symbol 
Selector
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Изоҳ: table of contents даги символни танлаш орқали асосий рангларни ҳам 
ўзгартириш имконияти мавжуд. 

2.

Бу машкда сиз турли хил хариталар танлаш оркали маълумотлар тўпламини 
кўрсатиш учун ўзгартирасиз.

2a. ‘Soil_types’ маълумотлар тўплами учун куйидаги шартли белгини тузинг: 
                                                                             Харита тури/Map type:Unique value 
                                                                             Майдон қиймати/Value field: Area

Бу харита тури ‘area’ атрибутини белгилашда мантиқий танлов ҳисобланадими? 
Жавобингизни тушунтиринг. 

2b. Харита турини ‘Graduated color’га ўзгартиринг; Value майдон учун ‘Area’
ни танланг. Нима учун ‘Soilcode’ атрибутини graduated colors да тақдим этишни 
имконияти мавжуд эмаслигини тушунтиринг. 

2с. ‘Soilcode’ атрибутини белгилаш учун мос бўлган харита турини/map type
танланг. 

2d. Symbology редакторининг Label field да тупроқ объектлари учун қисқа ном 
беринг. Ҳар хил синфларга индивидуал тарзда ранг беринг; ўзингизга ранг 
танланг ва шартли белгини харитага қўлланг. 

ХАРИТА ТАҚДИМОТИ УЧУН 12 ТА ҚАДАМЛАР

Харитани яратиш ва уни такдим этиш осон иш эмас. Бу бўлим сиз учун 
харитани тақдим этишнинг кўрсатмасини беради. Бу кўрсатма харита 
тақдимотининг 12 та қадамлари/ the 12 steps to present a map деб 
номланади. Буни бажаришда сиз АrcMapдан фойдаланасиз.

Харитани тақдим этишда қуйидаги 12 та қадамлар/саволларга жавоб берилади:

1. Харита кандай мақсадга/purpose хизмат қилади?
2. Фойдаланувчи гуруҳ/user group нимага йўналтирилган? 
3. Харитани номи/title қандай бўлиши керак?
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4. Шартли белгиларда кандай фазовий компонентлар/spatial components
кўрсатилган бўлиши керак?
5. Компонентлар ўртасидаги иерархия / hierarchy between нимадан 
иборат?
6. Бу компоненларнинг маълумот маштаби/data scale нима ҳисобланади?
7. Ҳар бир компонент нечта синфни/classes ўз ичига олади?
8. Қандай график символи/graphic symbol қўлланилиши мумкин?
9. Қандай график атрибутлар/graphic attributes ташкил топган бўлиши 
керак?
10. Шимолий кўрсаткични/North arrow қўшиш.
11. Маштаб панелини ёки харита координатасини қўшиш.
12. Маълумотлар манбасини, матн ва графикни қўшиш.

Маълумот масштаби / Data scale

Объектларнинг атрибут қийматлари сифатий ёки миқдорий ҳисобланади. 
Маълумот масштаблари қуйидагилар ҳисобланади: 

Nominal: Табиатан сифатий/qualitative атрибут қийматлари турли хил 
ҳисобланади, битта аспектсиз ҳам бошқалар (масалан: ердан фойдаланишнинг 
шакли) дан кўра кўпроқ муҳим бўлади. 

Ordinal: Сифатий/qualitative атрибут қийматлари бир-биридан фарқланади, 
лекин бу ерда битта йўл уларни тартибга солиш учун муҳим, баъзилари 
бошқаларга нисбатан муҳимроқ/кучлироқ ҳисобланади (масалан, йўлнинг 
муҳимлиги);

Interval: Миқдорий/Quantitative атрибут қийматлари турли хил ва тартибга 
солинган бўлиши мумкин. Индивидуал ўлчамлар ўртасидаги масофа 
аниқланган бўлиши мумкин (масалан: Цельсий/Celsius ҳарорат шкаласи)

Ratio: Миқдорий атрибут қийматлари турли хил ва тартибга солинган бўлиши 
мумкин. Атрибут сифат белгилари фарқланган ва тартибланган бўлиши 
мумкин. Индивидуал ўлчамлар ўртасидаги масофа аниқланган бўлиши мумкин 
ва бу индивидуал ўлчамлар бир - бирига боғлиқ бўлиши мумкин. Улар 
шунингдек, мутлоқ нольга эга бўлади (масалан: ташриф буюрувчилар сони).

График белгилар/ Graphic symbols

Харитада тасвирланган фазовий маълумотларда ҳар доим реал ҳодисалар 
назарда тутилади. Улар маълум нуқталарда ўлчанган тепаликлар, 
автомагистрал тизими бўйича ўлчанган йўл-транспорт ҳаракатлари, ёки 
ҳудудларда истеқомат қилувчилар сони бўлиши мумкин. Биз нуқта, чизиқ ва 
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ҳудуд жойларни тасвирловчи объектларни нуқта/point чизиқ/line ва ҳудуд 
(полигон)/area (polygon) орқали фарқлай оламиз. 

График атрибутлар/Graphic attributes

Символлар орасидаги барча фараз қилинадиган фарқларни қуйидаги 6 та 
график вариантлари орқали жамлаш мумкин (Bertin, 1983, 3 - расм):

• ўлчам/size
• кулранг қиймат/grey value
• текстура/textura
• ранг тури/color hue
• ориентация/orientation 
• шакл/shape

3-расм. Учта график символлар ва олтита график атрибутлар/Three graphic
symbols and six graphic attributes.

График атрибутлари тасодифий тарзда/randomly ишлатилиши мумкин эмас. 
Харитадан фойдаланувчи орқали турли йўлларда ҳар бири қабул қилинади ва 
улар фойдаланиш хоссасига мос ҳолда ўзгартирилади. Масалан, рангдаги фарқ, 
ориентация ёки шакл, сифат ёки хоссасидаги фарқни изоҳлайди. Лекин ўлчамда 
ёки рангдаги қиймат сифатда ёки миқдордаги фарқ каби изоҳлайди. Маълум 
бир график атрибутни танлаш харитада тақдим этилган атрибутнинг маълумот 
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шкаласига боғлиқ бўлади. 4-расм график атрибутларнинг рўйхати берилган 
бўлиб, қўпинча мос келадиган ҳар хил хоссаларни идрок этишни намойиш 
қилиш ҳамда бу маълумотлар шкаласи ва график атрибутлар ўртасидаги 
боғлиқликни кўрсатади.

4-расм. Маълумотлар шкаласи ва график атрибутлар ўртасидаги 
боғлиқлиқ./Relation between data scale and graphic attributes.

Хаританинг шартли белгиларини тайёрлаш (1–2, 4–9 қадамлар) 
/Preparing the map legend (steps 1 - 2, 4 - 9)

Фазовий маълумотларингизнинг харитасини яратишдан аввал, сиз 
харитангизнинг мақсади ва фойдаланувчилар гуруҳи ҳақида ўйлашингиз керак. 
Масалан, ҳарбийда фойдаланиладиган топографик харита оддий аҳоли учун 
фойдаланиладиган топографик харитадан фарқ қилади, чунки ҳарбийларни 
бошқа турдаги топографик маълумотлар (масалан: йўлларнинг эни) 
қизиқтиради, оддий аҳолини эса (йўллар иерархияси) қизиқарли. Бундан 
ташқари, топографик харита ердан фойдаланишни режалаштиришда жуда 
фойдали ҳисобланади, лекин курьер учун бундай эмас. Топографик харита 
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биринчи навбатда йўлларга қаратилмаган, у курьерга фойдали бўлиши учун 
жуда кўплаб чалғитувчи маълумотларни ўзида сақлайди. Нидерландиянинг ер 
шаклини ҳар хил турда кўрсатиб берувчи мактаб болалари учун 
мўлжалланган/лойиҳаланган харита атроф муҳит муҳофазаси бўйича 
шуғулланувчи мутахассис фойдаланадиган ер шакли харитасига қараганда 
жуда оддий (деталларда, шунингдек терминологияда) тузилган бўлиши керак. 
Харитада тақдим этилаётган фазовий маълумотларнинг жиҳати хаританинг 
мақсадига жавоб бериши ва фойдаланувчи гуруҳига мувофиқ бўлиши керак. 

Маълумот кўриниши макет кўринишига қарши  

Кейинги машқлар давомида ArcMapда яратилган мавжуд харита ёрдамида 
харита тақдимотининг 12 та қадамларини/ the 12 steps to present a map
амалиётда қўллайсиз. ArcMap харита кўринишининг 2 та йўлини таъминлайди:

 Маълумот кўриниши
 Макет кўриниши

Ҳар бир кўриниш харитада маълум йўналишларда қарашга ва ўзаро таъсир 
қилишга имкон беради. 

Маълумотлар тўпламингизни ‘тез кўриб’/’quick look’ чиқмоқчи бўлсангиз 
маълумот кўринишини/data view танланг. Сиз шу вақтгача маълумот 
кўринишида  ишлагансиз. Маълумот кўриниши тадқиқ қилиш, намойиш этиш 
ва маълумот бўйича сўров ўтказиш учун мақсадли кўриниш ҳисобланади. Бу 
кўриниш макет кўринишида яъни харита номланишини, шимолий кўрсаткични 
ва масштаб панелини аниқроғи барча харита элементларини сақлаган 
ҳолда/excludes all the map elements on the layout ҳамда оддий харита маълумот 
рамкаси учун мўлжалланган маълумотлар тўпламингизга имкон беради. 

Харитани тайёрлаётганингизда/ preparing your map яъни уни деворга 
осишда, ҳисоботга қўйишга ёки сайтда чоп этиш давомида сиз макет 
кўринишида/layout view ишлашни хохлашингиз мумкин. Макет кўринишида 
яъни сиз харита элементларини тартибга солиш ва жойлаштириш мумкин 
бўлган вертуал саҳифани кўрасиз/ you'll see a virtual page upon which you 
can place and arrange map elements. Сиз маълумот кўринишида деярли ҳамма 
нарсаларни бажаришингиз, шунингдек якуний харитангиз лойиҳасини 
яратишингиз мумкин. 

ҚЎЛЛАНМА:

1. Сиз menu bar даги View менюси орқали маълумот кўриниши/data view ва 
макет кўриниши/layout view ўртасида ўзгартиришингиз мумкин.
2. Ёки view window пастки қисмида чапда жойлашган иккита тугмадан 
фойдаланиб бу иккита кўринишни алмаштиришингиз мумкин. 
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3.

‘Map presentation2.mxd’ ҳужжатини ArcMapда очинг. Бу ҳужжат Soil map –
Wageningen south деб номланган жанубий Вагенинген ҳудудининг тупроқ
харитасини ўз ичига олади. View windowда layout viewни ҳосил қилинг.  

3a. Бу тупроқ харитаси учун харита мақсади ва фойдаланувчилар гуруҳига
мисол келтиринг. 

Харитангизнинг мақсади ва фойдаланувчилар гуруҳига асосланган ҳолда сиз 
харитангизда (шу йўсинда шартли белгилар ҳам) фазовий 
компонентлар/spatial components (маълумотлар тўплами) масалан, йўллар, 
ердан фойдаланиш, тупроқ турлари, шартли белгиларда компонентларнинг
иерархиясидан/hierarchy ташкил этилишига қарор берасиз. Тупроқ 
харитасининг шартли белгилари иккиламчи маълумотлардан яъни қурилиш
ҳудудлари ёки йўллардан эмас, балки тупроқ туриларидан бошланиши керак. 
Сўнгра, бу компонентларнинг маълумот масштабини/data scale аниқлайсиз. 
Бу муҳим, чунки маълумот масштаби символларни (график белгилар ва 
атрибут) аниқлайди, бу эса фазовий маълумотларни намойиш этишда мос
ҳисобланади. Ундан кейин ҳар бир компонентда мавжуд бўлган
категория(синф) сони/ number of categories(classes) билан давом эттирасиз. 
Катта йўлларни иккинчи даражали йўлдан ажратишингиз керакми ёки йўқми? 
Агар ‘ҳа’ десангиз, катта йўлларни ташкил этувчи компонент қийматлари ва
иккинчи даражали йўллар қийматлари ажратилган синфлардан шу йўсинда
турли символларга тегишли. Компонент синфларнинг сони харитангизнинг
аниқ мақсадига боғлиқ бўлади. Харитада фазовий компонентларни қандай
тақдим этишни ҳал қилиш якуний қадам ҳисобланади. Компонентларнинг
маълумот масштабига мувофиқ равишда мос график белгиларни/graphic 
symbols ва атрибутларни/attributes танланг.

4.

Сиз бу машқда ArcMapда яратилган ‘харита тақдимотининг 12 та
қадамларини’/ ‘12 steps to present a map’ амалиётда бажарасиз. 

Намойиш ойнаси макет кўринишида/layout view эканлигига ишонч ҳосил
қилинг. Агар сиз харитангизни каттароқ вариантда (тўлиқ экранда) кўрмоқчи
бўлсангиз,  menu bar дан File => Print Preview ни танланг.
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Бу ерда ўрганилаётган ҳудуд жанубий тупроқ харитаси намойиш этилган.

4а. 1-жадвалга бу харита қандай яратилишининг 4 - 9 қадамларини тасвирланг. 

4b. 3 ва 4 расмларга мувофиқ танланган график атрибутлар ҳақида сизнинг 
фикрингиз қандай? 

4-қадам
Фазовий 

компонентлар

5-қадам
Компонент 
иерархияси

6-қадам
Маълумот 
масштаби

7-қадам
Компонент 

синфи

8-қадам
График 

символлар

9-қадам
График 

атрибутлар

1-расм. ‘харита тақдимотининг 12 та қадамлари’ усули бўйича 4 дан 9 гача 
бўлган қадамлар/ Steps 4 to 9 of the ‘12 steps to present a map’ approach.

Бу машқни тугатганингизда ArcMap ҳужжатини сақламасдан ёпинг.

Харита макети ва харитани босмадан чиқариш (3 & 10 – 12 
қадамлар)

4-9 қадамларни бажариш давомида сиз харитангизда тақдим этишни хохлаган 
фазовий компонентларни (маълумотлар тўплами) яъни компонент 
иерархиясини, атрибут масштабини, синфлар ва символларни аниқлашингиз 
керак. Шунингдек, сиз балки харитангизда киритишни хохлаган маълумотлар 
билан яъни маълумотлар тўпламининг объектларини этикеткалашингиз керак. 
Эҳтимол, сизнинг харитангиз ҳали босмага беришга тайёр эмасдир. Унда ҳали 
ҳам баъзи бир муҳим харита элементлари етишмаслиги мумкин: 
номланиши/title, масштаб панели/scale bar, шартли белги/legend, шимолий 
кўрсаткич/north arrow, тавсифловчи матн/descriptive text ва баъзи 
графиклар/graphics.
Макет/layout сизга харитангизда тақдим этишни хохлаган фазовий 
компонентларни ва харита элементларни йиғишга/ assemble, хохлаган дизайн 
бўйича лойиҳалашга/ arrange ва тайёр бўлганда босмадан чиқаришга/print
имкон яратади. 
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Макетлар ArcMapда сифатли тақдимотни ишлаб чиқиш учун осонлик яратади. 
Сиз ArcMap ҳужжатингизда ҳар қандай диаграммаларни ва жадвалларни 
биргаликда макет ичига биттадан кўп маълумот рамкасини жойлаштиришингиз 
мумкин. Агар кейин фикрингизни ўзгартирсангиз, макетда қўйилган талаб 
бўйича ҳар бир элементни қўшиш, ўчириш, ўлчамини ўзгартириш ва кўчириб 
ўтказишингиз мумкин. 

Бу бўлим макетни қандай яратиш тавсифи билан давом эттирилади ва унга 
хаританинг турли элементларни қандай қўшиш кераклиги ҳамда мустақил 
ҳолда макет ярата олганингизда машқ якунланади.          

Харита макетини яратиш 

ҚЎЛЛАНМА:

1. Ҳужжатни очинг ва харитада тақдим этмоқчи 
бўлган маълумотлар тўпламини белгиланг.
2. View window да макет кўринишини/layout view
жойлаштиринг. 
3. Меню панелида/ menu bar Insert текст менюсидан 
харитангизга элементларни қўшиш учун  барча керакли 
тугмаларни топишингиз мумкин (5-расм). Бу тугмалар 
фақатгина макет кўринишда бўлгандагина актив 
ҳолатда бўлишига эътибор беринг. 

Layout view актив ҳолатда бўлгандагина созлаш 
параметрини/settings ўзгартириш имконияти бўлади. 
Тасаввур қилинаётган маълумотлар тўпламининг 
ўлчамини ва жойини ўзгартириш мумкин бўлади. 
Макет кўринишида ўнг тугмани босган ҳолда 
макетнинг турини/type ва бетларни тузатиш 
параметрларини/page settings ўзгартириш мумкин.

Макетга маълумот рамкасини қўшиш

Макетнинг марказий элементи бу маълумот рамкаси ҳисобланади. Бу рамка 
маълумотлар тўпламингизни тақдим этади. Макетингизда биттадан кўп бўлган  
маълумот рамкасига эга бўлишингиз мумкин. Оддий хариталар одатда битта 
маълумот рамкасига эга бўлади. Баъзи ҳолларда ўзгаришларни вақт билан 
кўрсатишингизга тўғри келади, масалан, мамлакатда ердан фойдаланиш 1980, 
1990 ва 2000 йилларда. Агар иш шундай бажарилиш керак бўлса, у ҳолда Сиз 
харитага 3 та маълумотлар рамкасини қўшишингиз мумкин. Ҳар бир рамка 
ердан фойдаланишни тегишли даврига эга.

5-расм. Харита объекти 
тугмалари/Map feature buttons
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ArcMapда макетдаги table of contentsда мавжуд бўлган барча маълумот 
рамкалари фойдаланилади. Агар сиз table of contentsда  иккита маълумот 
рамкасига эга бўлсангиз, сиз беихтиёр иккита маълумот рамкасини макетда 
кўришингиз мумкин. 

Огоҳлантириш: макетдан шунчаки бирор бир маълумотлар рамкасини ўчириб 
ташлаш мумкин эмас. Агар бу ишни қилсангиз мундарижадан тегишли бўлган 
маълумотлар тўпламини, шунингдек бир вақтнинг ўзида бутун харита 
ҳужжатини entire map document ҳам ўчирган бўласиз!!! Агар сиз 
макетингизда кўп сонли маълумот рамкаси бўлишини хохламасангиз, сиз 
мундарижада битта маълумот рамкаси ичида маълумотлар тўпламини қайта 
тузишингиз керак бўлади ва қолган рамкаларни ўчириб ташлашингиз мумкин.
Макет кўринишида рамкаларнинг хоссаларини ўзгартириш имконияти мавжуд: 
рамканинг ўнг тугмасини босиб, Propertiesни танланг. Масалан сиз рамканинг
чегарасини ўзгартиришингиз, масштабни жойлаштиришингиз ёки 
координаталарни харитага қўшишингиз мумкин. 

Харита макетига шартли белгини қўшиш

Шартли белги/legend харитадан фойдаланувчига объектларни тақдим этишда 
харитада қандай символлар мавжудлигини билдиради. Макетда шартли белги 
мундарижада аввалдан фойдаланилган шартли белги билан боғлиқ 
ҳисобланади. Сиз маълумотлар тўпламининг белгисини/symbology
ўзгартирсангиз у беихтиёр макетда шартли белгини ўзгартиради.

ҚЎЛЛАНМА: 

1. Меню панелидан Insert => Legend ни танланг (бу фақат layout view да 
бўлганингизда ишлайди) 
2. Пайдо бўлган ойнада, шартли белгига қўшмоқчи бўлган маълумотлар 
тўпламини танланг. Сиз шунингдек, шартли белгиларда (иерархия тўғрисида 
ўйланг) юқорига ва пастга қараган стрелкалар ёрдамида маълумотлар 
тўпламининг тартибини/order ўзгартиришингиз мумкин. Next ни босинг.
3. Қуйидаги ойнада шартли белгиларни ўрнатиш учун баъзи вариантлар 
пайдо бўлади. Истасангиз, ушбу вариантлар билан хохлаганингизча иш олиб 
боришингиз мумкин. 
4. Макетда жойлашган шартли белгини кўчириб ўтказиш ва уни ўлчамини 
ўзгартиришингиз мумкин.
5. Агар сиз натижадан қониқмасангиз, ҳар доим шартли белгини 
алмаштиришингиз мумкин. Макетдаги шартли белгининг ўнг тугмасини босинг 
ва пайдо бўлган менюдан Properties танланг. Legend Properties ойнаси очилади 
ва у ердан баъзи шартли белгиларни тартибга солишингиз  мумкин. 
Ҳар доим бирор маълумотлар тўпламининг номини table of contentsни танлаш 
орқали ўзгартиришингиз мумкин.  
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Харита макетига шимолий кўрсаткични қўшиш/Adding a north 
arrow to a layout

Шимолий кўрсаткич хаританинг йўналишини билдиради.

ҚЎЛЛАНМА:

1. Menu bar дан Insert => North Arrow ни танланг (бу фақат layout view
кўринишида бўлсангизгина амални бажаришингиз мумкин).
2. North Arrow Selector менюсидан шимолий кўрсаткичнинг стилини/style
танлашингиз мумкин. 
3. Properties тугмасини танланг ва аниқ бир ўлчамга келтириш бурчагини
/calibration angle ишга тушириш учун North Arrow ни босинг. Стрелканинг 
ўлчамини, стилини ва шрифтини ҳам ўзгартиришингиз мумкин.
4. OKни босинг ва шимолий кўрсаткични макетда мос жойга кўчириб 
ўтказинг. 

Харита макетига масштаб панелини қўшиш/Adding a scale bar to 
a layout

Масштаб панели/scale bar объектларнинг ўлчамини ва харитада объектлар
орасидаги масофанинг визуал ишорасини таъминлайди. Масштаб панели
бўлакларга бўлинган чизиқча ёки панелдан иборат бўлиб, ернинг узунлиги
билан белгиланади. Одатда харита бирликларининг бўлинадиган сонлари яъни
ўнли километрда ёки юзли милда белгиланади. Агар харита кенгайтирилса ёки
қисқартирилса, масштаб панели тўғрилигича қолади. 

Масштаб панелини макетга маълумотлар тўпламидан ва шартли белгидан
кейин қўшинг. 

Изоҳ: Макетга масштаб панелини қўшишдан аввал маълумотлар рамкасининг  
харита бирликлари /map units метрда/meters ўрнатилганлигига ишонч ҳосил
қилинг!!! Буни текшириш учун меню панелидан  View=>Data 
Frame=>Properties=> General ни танланг

ҚЎЛЛАНМА: 

1. Menu bar дан Insert => Scale Bar ни танланг (бу фақат layout view
кўринишида бўлсангизгина амални бажаришингиз мумкин).
2. Сиз ичига ўрнатмоқчи бўлган масштаб панелини танланг ва OK ни 
босинг.
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3. Макетга қўшилган масштаб панелининг ўлчамини ўзгартиришингиз ва 
кўчириб бошқа жойга ўтказишингиз мумкин. Масштаб панелининг жуда 
кичкина эмаслигига ишонч ҳосил қилинг! 
4. Properties ойнасини очиш учун масштаб панелининг устига икки марта 
босинг. 
5. Бу ойнада масштаб ва бирликлар /scale and units  ҳамда сонлар ва 
белгилар /marks and numbers иловалари муҳим ҳисобланади. 
6. Scale and Units иловасида Тақсимлаш қиймати /Division value ни 
ўрнатиш мумкин (жуда кичик бўлмаган), number of divisions, number of
subdivisions ва масштаб панелида қайта ўлчаниши керак бўлгандаги амалларни 
бажаради (‘adjust division value’ дан фойдаланманг, чунки тақсимлаш қиймати 
‘round number’ да яъни 1 км, 500 м ва ҳоказо бўлиши мумкин). 
7. Масштаб панели бирликларини/units танланг. 
8. Number and Marks иловасида сонли қиймат қанчалик пайдо бўлишини 
масштаб панелида аниқлаш ва уни қаерда жойлаштириш имконияти туғилади. 
9. Apply ва OK тугмаларини босинг.  

Харита макетига матн ва бошқа графикларни қўшиш/Adding text 
and other graphics to a layout

ҚЎЛЛАНМА: 

1. Сиз Text ускунасидан сарлавҳа/titles учун матн/text ва бошқа
тасвирловчи матнларни/descriptive text қўшиш учун фойдаланишингиз
мумкин, шунингдек, чизиш/drawing асбобини қутича/boxes, айлана/circles ва 
стрелка/arrow каби графикларни/graphics макетда қўшиш учун ишлатишингиз
мумкин.
2. Чизиш асбоби/drawing tools Draw ускуналар панелида пастга қараган
рўйхатда жойлашган. 
3. Сиз ҳар доим маълумотлар рамкасининг хоссаларини ўзгартира оласиз: 
макетда рамканинг ўнг тугмасини босинг ва Properties ни танланг. 

5.

‘Map presentation3.mxd’ ҳужжатини ArcMapда очинг. 

‘De Hoge Veluwe’ миллий боғида маълумот куни учун паркни кўришга тафриш
буюрувчиларнинг сони бўйича маълумот берувчи харита яратилиши керак. Энг
муҳими 1995 йил Пасха кунида паркда турли қулайликларга эга бўлган ташриф
буюрувчиларнинг сони ҳисобланади. Бу куни Фазовий режалаштириш/Spatial 
Planning факультети магистранти М.Янсен (M.Janssen),турли имкониятларда



102

тафриф буюрувчиларни санади. 

Ташриф буюрувчилар сони ҳақидаги маълумотларни 'facilities' маълумотлар
тўпламидаги Vzon майдонидан оласиз.

5а. Харитани тақдим этиш учун 12 қадамни ёзинг. 4 қадамдан то 9 қадамгача 
бўлган жараёнларни олдин бажарган тартибда схема кўринишида беринг. 

5b. ArcMapдан фойдаланиб, ‘харита тақдимотининг 12 та қадамларини’/ ‘12 
steps to present a map’ орқали харита яратинг. 
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5-амалий машғулотни бажаргандан кейин ўз-ўзини
текшириш учун саволлар
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Саволлар

1. ArcMap да фазовий маълумотлар нималарни билдиради? 
2. Харита тақдимоти нимани ўргатади?
3. Белгилар редакторида/Symbology editor нечта Категориялар/Categories 
мавжуд ва уларга таъриф беринг. 
4. Белгилар редакторида / Symbology editor нечта миқдорлар/Quantities:ies 
мавжуд ва уларга таъриф беринг. 
5. Белгилар редакторида / Symbology editor нечта диаграммалар/Charts:ies 
мавжуд ва уларга таъриф беринг. 
6. Кўп сонли атрибутлар/Multiple attributes нимани кўрсатади? 
7. Харитани тақдим этишдаги 12 та қадамлар/саволлар нималар иборат? 
8. Маълумот масштаблари нималар ҳисобланади ва уларга таъриф бериф 
беринг?
9. Символлар орасидаги барча фараз қилинадиган фарқларни нечта график 
вариантлари орқали жамлаш мумкин ва улар қайсилар? 
10. ArcMap харитада маълумотлар тўпламини ‘тез кўриб’/’quick look’ чиқиш 
учун қайси кўриниш танланади ва унган таъриф беринг. 
11. Макет кўринишига/layout view таъриф беринг. 
12. Тупроқ харитасини яратишда шартли белгилар нимадан бошланиши 
керак? 
13. Харитани тақдим этишда макетнинг/layout имкониятларни санаб ўтинг.
14. Макетдан шунчаки бирор бир маълумотлар рамкасини ўчириб ташлаш 
мумкин эмас. Бунга сабаб нима? 
15. Масштаб панелига /scale bar таъриф беринг. 
16. тext ускунаси ва чизиш/drawing асбоби орқали харита макетида қандай 
вазифаларни бажариш мумкин?


